CHAPTER

Working with the Cisco Prime Network Vision
Client

The following topics describe the user access roles required to use Cisco Prime Network Vision (Prime
Network Vision), the Prime Network Vision working environment, and how to access the Prime Network
Vision tools and commands:

e User Roles Required to Work with Basic Operations in Prime Network Vision, page 2-1
e Launching Prime Network Vision, page 2-2

e Changing Your GUI Client Password, page 2-3

e The Prime Network Vision Window, page 2-3

e Prime Network Vision Status Indicators, page 2-16

¢ Prime Network Vision Toolbar, page 2-22

e Prime Network Vision Menu Bar, page 2-24

e Prime Network Vision Right-Click Menus, page 2-29

e Adjusting the Prime Network Vision GUI Client Settings, page 2-39

e Filtering and Sorting Tabular Content, page 2-40

User Roles Required to Work with Basic Operations in Prime
Network Vision

Table 2-1 identifies the GUI default permission or device scope security level that is required to work
with Prime Network Vision. Prime Network Vision determines whether you are authorized to perform a
task as follows:

e For GUI-based tasks (tasks that do not affect devices), authorization is based on the default
permission that is assigned to your user account.

e For element-based tasks (tasks that do affect elements), authorization is based on the default
permission that is assigned to your account. That is, whether the element is in one of your assigned
scopes and whether you meet the minimum security level for that scope.

For more information on user authorization, see the Cisco Prime Network 3.10 Administrator Guide.

By default, users with the Administrator role have access to all managed elements. To change the
Administrator user scope, see the topic on device scopes in the Cisco Prime Network 3.10 Administrator
Guide.
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Launching Prime Network Vision

Table 2-1 Default Permission/Security Level Required for the Basic Prime Network Vision
Functions

Task Viewer Operator  |OperatorPlus | Configurator Administrator

Start Prime Network X X X X X

Vision

Change a user password |—! —! —! —! X!

in Prime Network

Vision

Set Prime Network X X X X X

Vision options

Work with Prime X X X X X

Network Vision tables

1. Each user can change their own password, but only the Administrator role can change another user’s password.

Launching Prime Network Vision

Prime Network Vision is password protected to ensure security. Before you start working with Prime
Network Vision, make sure you know your username and password. If you use the standalone
application, you also need to know the Prime Network Vision gateway IP address or hostname.

e Launch Prime Network Vision from Prime Central—Choose Assure > Prime Network > Vision in
the menu bar. The Prime Network Vision application is opened in a separate window. For
information on Prime Central, see the Cisco Prime Central User Guide.

e Launch Prime Network Vision as a Standalone Application—Choose
Start > Programs > Cisco Prime Network > gateway IP address > Cisco Prime Network Vision,
and enter your username and password. If any client updates are available, Prime Network
automatically installs them.

If you see messages that say the server and client have different versions of the application, you need
to update your client as described in the Cisco Prime Network 3.10 Installation Guide.

Once the GUI client is displayed, open an existing map or create a new one; see Working with Prime
Network Vision Maps, page 5-1.

After logging into Prime Network Vision and launching the application, you can customize the Prime
Network Vision settings. For example, you can:

¢ Load the content pane with information when starting Prime Network Vision.

e Display network elements in the Prime Network Vision content pane and navigation pane.
¢ Configure audio responses when different alarms are triggered.

e Specify the length of time that events should be displayed in the inventory window.

For more information on customizing Prime Network Vision startup and display options, see Adjusting
the Prime Network Vision GUI Client Settings, page 2-39.
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Changing Your GUI Client Password

Changing Your GUI Client Password

The method used to change your password depends on whether authentication is provided by Prime
Network or an LDAP server. If you can see the Tools > Change User Password choice in the Prime
Network Vision menu, the system is using authentication provided by Prime Network. You can change
your password by entering the old and new passwords.

If the menu choice is disabled, the system is using an external authentication method. To change your
password, contact your administrator. For more information about user authentication, see the
Cisco Prime Network 3.10 Administrator Guide.

The Prime Network Vision Window

Figure 2-1 displays the Prime Network Vision window with an open map.

Je

Tip The ticket pane can be displayed or hidden by clicking the arrows below the navigation pane (see Callout
7 in Figure 2-1).

Cisco Prime Network 3.10 User Guide
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B The Prime Network Vision Window

Figure 2-1 Prime Network Vision Window
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Prime Network Vision Inventory Tabs

Prime Network Vision includes the following inventory tabs:

e Network Elements—Lists all network elements with the information described in Table 2-7,
Network Element Information Displayed in List View. If there are tickets associated with the
element, an icon is displayed. The color of the icon indicates the ticket severity.

e FEthernet Flow Domains—Lists all Ethernet flow domains, including the domain name, the
system-defined domain name, and a brief description for each domain. For more information about
Ethernet flow domains, see Viewing and Renaming Ethernet Flow Domains, page 13-41.

e VTP Domains—Lists all VTP domains. For more information about VTP domains, see Viewing
VLAN Trunk Group Properties, page 13-67.
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The Prime Network Vision Window 1l

e Virtual Machines—Lists all the virtual machines. For more information about virtual machines, see
Viewing the Virtual Machines of a Data Center, page 27-13. If there are tickets associated with the
virtual machine, an icon is displayed. The color of the icon indicates the ticket severity.

To open an inventory tab, choose Network Inventory in the menu bar, and choose the required option.
The selected inventory table is displayed as shown in Figure 2-2.

Figure 2-2 Prime Network Vision Inventory Tabs
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Prime Network Vision Maps

You can create as many maps as required to represent the network views you need. For example, maps
can include specific network segments, customer networks, or the particular network elements and
services that you require. Each map has three major areas:

¢ A tee-and-branch representation of the network elements and aggregations in the current map. For
more information, see Navigation Pane, page 2-6.

¢ A large area showing the map elements and links in a map (topological layout) or in list format. For
more information, see Content Pane: Map, List, and Links Views, page 2-7.

e A table of tickets associated with elements displayed in the map. For more information, see Ticket
Pane, page 2-16.
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Opening Maps

You can open up to five maps at one time. To open a map, choose File > Open Map. The Open Map
dialog box is displayed (see Figure 2-3).

Figure 2-3 Open Map Dialog Box
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A check mark in the Opened column indicates that the map is already open. Map tabs display the root
node icon and name.

In addition, the icon color reflects the highest severity ticket that is not cleared in the map, and an alarm
icon indicates the severity of the highest severity ticket that is not acknowledged. For more information
about maps, see Working with Prime Network Vision Maps, page 5-1.

You can open up to eight tabs at one time.

Navigation Pane

The navigation pane displays a tree-and-branch representation of the network elements and aggregations
defined for the loaded map.

The highest level in the navigation tree displays root node icon with the map name. When the map name
is changed, the Prime Network Vision window is updated, and the new map name is displayed at the top
of the navigation tree and in the window title bar.

The lowest level of the navigation tree displays a single network element or service, such as a port,
Ethernet flow point, or bridge.

Cisco Prime Network 3.10 User Guide
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The navigation pane can include up to two icons for each element. These icons can include alarm icons,
communication or investigation state icons, and badges, as shown in Figure 2-4. Alarm icons are always
displayed next to the element icon.

Figure 2-4 Navigation Pane with Icons
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For information about the status of network objects, see Prime Network Vision Status Indicators,
page 2-16.

Content Pane: Map, List, and Links Views

The content pane enables you to view and modify low-level information. It supports the following views:

Map view—Displays managed network elements on a geographical map. For more information, see
Map View, page 2-7.

List view—Displays the details of the network elements contained in the currently selected
hierarchy or subnetwork (map), such as the IP address and system name. For more information, see
List View, page 2-11.

Links view—Displays a complete list of the links in the map view and their status. For more
information, see Links View, page 2-14.

Map View
Click Show Map View on the toolbar to display the map view in the Prime Network Vision window. In
the map view, Prime Network Vision displays:
e Aggregations
e Managed network elements
— Each network element is displayed as an icon, the color of which reflects severity, as described
in Alarm Indicators, page 2-11.
— Depending on the size of the icon, additional information can be displayed. For more
information, see Information Available in Element Icons, page 3-3.
e Ethernet flow point cross-connects
e Ethernet services
e MPLS-TP tunnels
e Pseudowires
e VLANs
e VPLS instances
e VPNs
Cisco Prime Network 3.10 User Guide
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e Links
- Service and business links are represented as well as physical and topological links.

— Unidirectional links include arrowheads that indicate the direction of the flow, while
bidirectional links do not have arrowheads.

¢ Relationships between network elements, aggregations, and networks

You can move network elements manually on the map by dragging the required icon. You can also click
Layout Map in the toolbar or use your mouse to change the way the elements are displayed on the map.
For more information about working with maps, see Chapter 5, “Working with Prime Network Vision
Maps.”

Element Icons

To view icons more easily, zoom in with your mouse. Four sizes are supported. Table 2-2 provides
examples of each. For more details about data this is displayed, see Information Available in Element
Icons, page 3-3.

Table 2-2 Prime Network Vision Element Icon Sizes

Example Icon Name and Description

Tiny—Elements are displayed as dots. Alarm severity is indicated by colors.

— Normal—FElements are displayed with icons and names. Alarms include
e badges. Alarm severity is represented by colors.

€7-5w10 [IN]

=3 CT-sn6

c7-sw9 [IM+ T

VLANS [1M]

Large—Same as Normal, with additional NE properties. You can also
perform cut-and-paste operations by pressing and dragging the mouse scroll

PE1-7204-As [2W]
=2 C 04VR
té 2 wheel over the text.

Huge—Same as Normal, with additional action buttons.
C9-AGG20 [16M+]

B Cisco ASR 9006
< 10.56.101.154
® 4.0.1[Default]

Prime Network Vision also provides additional features for working with aggregations. For more
information, see Working with Aggregations, page 5-16.

The following tables identify some of the icons used to represent network elements and business
elements in the Prime Network Vision window’s navigation pane and content pane:

e Table 2-3, Network Element Icons

e Table 2-4, Business Element Icons
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For a complete list of the icons and their descriptions, see Appendix A, “Icon and Button Reference.”

Table 2-3 Network Element Icons
Icon Network Element Icon Network Element
Access pseudowire Cloud

)
»

Router

4 |ATM switch E—® |Digital subscriber line access multiplexer
x —, |(DsLAM)
Basic rate access (BRA) Ethernet switch
~% =1
Cisco 7600 series router Generic SNMP device
+
S Cisco ASR 1000 series router Ghost, or unknown device
i
—#71 |Cisco ASR 5000 series router ICMP device
)
L)
Cisco ASR 9000 series router ﬁ Lock, or security violation; viewable by a user with
_ | a higher permission level
i=71 |Cisco CRS series router P\;‘j Missing icon or ghost NE (the NE was deleted and
EE &4 |is no longer managed, or there is no icon for this

NE)

Sun Netra server

Cisco MWR 3941

#

=

'WR-

r
)
=
w

Cisco Nexus 1000 series Service control switch

devices

Cisco IOS XR 12000 series WiFi element

router

& O
I

Cisco Unified Computing
System (UCS)

i
B
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Table 2-4 Business Element Icons
Icon Business Element Icon Business Element
=] [Aggregation or root node ' Network Traffic Profile (TP) tunnel

o
&

Backup pseudowire edge Network VLAN

Connection termination point (TP)
Ethernet flow point (EFP)
MToP service

Pseudowire edge

7 |
5
[Ei et

EFP cross-connect Pseudowire switching entity

Ethernet service Subnet

aHaé

Ethernet virtual connection (EVC) Switching entity

B C &

Label-Switched Path (LSP) endpoint TP tunnel endpoint

@
i

LSP midpoint VPLS forward

Missing icon or ghost NE (the NE was VPLS instance
deleted and is no longer managed, or

there is no icon for this NE)

Network LSP
Protected LSP
Working LSP

Network pseudowire

VPN
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Links

Prime Network Vision maps contain graphical links that can represent multiple physical, topological,
service, and business links. The maximum number of graphical links that can be displayed is specified
in the registry. If the number of graphical links exceeds the specified limit, a warning message with a
Refresh button is displayed, and the map is surrounded by a red border. The presence of a red border
around a map indicates that some links exist that are not displayed in the map.

Cisco Prime Network 3.10 User Guide
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To reduce the number of graphical links in a map, click Link Filter in the toolbar, and uncheck the check
boxes for the links you do not need to view.

Links in maps have tooltips that provide you with information regarding the link endpoints and the
number of links represented by the selected link in the map. Click the link tooltip to view additional
information about the link in a link quick view window. Click Properties in the link quick view window
to open the link properties window. For more information about viewing link properties, see Viewing
Link Properties in Prime Network Vision Maps, page 6-4.

If you apply a link filter to the map, the link tooltip displays only the relevant links.

Table 2-5 shows the colors that are used to display the severity (or propagated severity) of a network
element. The same coloring conventions apply to the link severities.

Table 2-5 Severity Indicators
Icon Color Severity Icon Color Severity
o Red Critical @ Light Blue Warning
.@ Orange Major Medium Blue Information
Yellow Minor Dark blue Indeterminate
Green Cleared, Normal, or
OK

The color of a selected link can be customized. The default color is blue.

Many functions can be performed by using the right-click menu in the map view, including launching
external applications or tools. Some of these functions are also available in the navigation pane, links
view, and ticket pane.

The specific options that are available in the right-click menu depend on whether you select a network
element, click in the map background, select an aggregation, or select a ticket in the ticket pane. For
details on the specific right-click options that are available for each scenario, see Prime Network Vision
Right-Click Menus, page 2-29.

Click Show List View in the toolbar to display the Prime Network Vision list view. The list view displays
the tabs described in Table 2-6, depending on the items included in the current map and the item selected
in the navigation tree.
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Table 2-6 Prime Network Vision List View Tabs
Tab Description
Aggregations Aggregations in the current map.

Connection TP

Connection termination points (TPs) in the current map.

EFP Cross-Connect

EFP cross-connects in the current map.

Ethernet Flow Points

EFPs in the current map.

Ethernet Services

Ethernet services in the current map.

EVCs

EVCs in the current map.

Network Elements

Network elements in the current map that are in the user’s scope.

Network Pseudowire

Network pseudowires in the current map.

Network TP Tunnel

Network Traffic Profile (TP) tunnels in the current map.

Pseudowires

Pseudowires in the current map.

Pseudowire Edge

Pseudowire endpoints in the current map.

PW Switching Entity

Pseudowire switching entities in the current map.

Restricted Elements

Network elements in the current map that are not in the user’s scope.

Sites

Sites for the selected VLAN. Site properties include site name, description,
location, and IP interface.

Switching Entities

Switching entities in the current map.

Virtual Routers

Virtual routers on the selected VLAN. Virtual router properties include the
virtual router name and description.

VLANSs

VLANS in the current map. VLAN properties include VLAN name,
identifier, description, and Ethernet flow points.

VPLS Forward

VPLS forwards in the current map.

VPLS Instance

VPLS instances in the current map.

VPNs

VPNs in the current map. VPN properties include VPN name and description

Table 2-7 describes the network element properties displayed in the Network Elements tab. (Locked
network elements display only managed element information and the locked element icon.) To ensure
that you are viewing the latest information, either perform a new search or click the Refresh button.

Table 2-7 Network Element Information Displayed in List View

Field Name Description

Name Name of the network element managed by Cisco, as defined in Cisco Prime
Network Administration. The Name property also displays a network
element icon. The icon color reflects the highest network element alarm
severity. In addition, the management state or an alarm icon is displayed.

IP Address IP address used for managing the network element.

System Name

System name of the network element, as defined in the network element's
MIB. If the network element is configured for Telnet access, the prompt is
displayed.

Severity

Current operational health of the network element.

] Cisco Prime Network 3.10 User Guide
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Table 2-7 Network Element Information Displayed in List View (continued)

Field Name Description

Unacknowledged Severity of the most severe unacknowledged ticket.

Communication State | Ability of the VNE to reach the network element, according to the health of
the element. For more information about communication states, see the
Cisco Prime Network 3.10 Administrator Guide.

Investigation State Level of network element discovery that has been performed or is being
performed by the VNE. For more information about investigation states, see
the Cisco Prime Network 3.10 Administrator Guide.

Vendor Vendor name.

Product Network element category, such as Router or Eth-Switch (Ethernet switch).

Device Series Device series, such as Cisco 7600 Series Routers.

Element Type Network element type including the manufacturer’s name, such as
Cisco 7200.

Software Version Cisco IOS software version running on the network element.

Location Location of the network element.

Up Since Date and time the network element was last reset.

Tip Click the red triangle in a cell to expand the cell and view all the information it contains. You can also
use a tooltip to view all the information.

See Filtering and Sorting Tabular Content, page 2-40 for more information about filtering, finding

details about a network element in Prime Network Vision tables.

Table 2-8 describes some of the functions that are available from the right-click menu in the list view.

You must select an item for the right-click menu to appear. Not all options are available for all selections.

Table 2-8 List View Right-Click Options

Right-Click Option

Function

Related Documentation

Inventory View network element inventory The Inventory Window, page 3-9
Poll Now Poll the selected element
Attach / Detach / Edit Configure and view business tag information Chapter 7, “Labeling NEs Using

Business Tag

Business Tags”

Config Mgmnt

View the Configuration Management page in

Chapter 4, “Device Configurations and

Prime Network Change and Configuration
Management

Software Images”

Image Mgmnt

View the Image Management page in Prime
Network Change and Configuration Management

Chapter 4, “Device Configurations and
Software Images”

Run Report Generate reports Chapter 11, “Working with Reports”
Tools Ping or telnet a VNE, or check VNE CPU usage |List View Right-Click Menu, page 2-35
Topology Configure the topology Adding Static Links, page 6-15
Cisco Prime Network 3.10 User Guide
| oL-28065-01 .m


http://www.cisco.com/en/US/products/ps11879/prod_maintenance_guides_list.html
http://www.cisco.com/en/US/products/ps11879/prod_maintenance_guides_list.html

Chapter2  Working with the Cisco Prime Network Vision Client |

B The Prime Network Vision Window

Table 2-8 List View Right-Click Options (continued)
Right-Click Option Function Related Documentation
Properties View network element properties Viewing the Properties of a Network
Element, page 3-6
Commands Launch any of the commands that are included Configuring and Viewing NEs using
with Prime Network Vision Basic Management Commands,
page 3-37
Management Access Command Builder and Soft Properties Cisco Prime Network 3.10
Management Customization Guide
VNE Tools Poll a VNE, or start or stop a VNE Performing a Manual Device Poll,
page 3-18

Tip Click a column heading in a table to sort the information by that property.

Links View

Click Show Links View in the toolbar to display the links view in the Prime Network Vision window.

Maps can contain many graphical links, each of which can represent multiple physical, topological,
service, and business links. This can make it difficult for you to view the links you are interested in. In
addition, if the number of graphical links exceeds the number that can be displayed in a map, not all links
are displayed. By using the links view, you can view all links in the map, as well as search for a specific
link and view the status of a link.

Note  You can view and filter the links according to type by using the Link Filter dialog box. For more
information, see Filtering Links in a Map, page 5-25.

Any links that are added or removed from the map are automatically added or removed from the links
view, provided they have not been filtered out.

The links view is selection sensitive; that is, the links displayed in the links view depend on the context
selected in the navigation pane or map. For example, if an aggregation is selected, the links in the
selected aggregation are displayed in the links view.

Cisco Prime Network 3.10 User Guide
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Figure 2-5 shows a links view.

Figure 2-5 Links View
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Note  An external link has a blue cell background in the table, and you can open the inventory window by
clicking the hyperlink. For more information about external links, see Viewing Link Properties in the

Links View, page 6-8.

Table 2-9 describes the information that is displayed in the links view.

Table 2-9 Information Displayed in the Links View
Field Name Description
Context Name of the map or aggregation containing the link.
This field can be empty for either of the following reasons:
* One side of the link is not included in the map.
e The link is filtered out of all contexts.
Severity Link alarm severity, represented by an icon. The icon and its color indicate the
alarm severity and thereby the impact of the alarm on the network. For more
information about severity, see Map View, page 2-7.
A End-Point Element or site that is the source of the link as a hyperlink to the inventory of the
element or site.
Bi Directional Whether the link is bidirectional or unidirectional: true (bidirectional) or false
(unidirectional). If the link is unidirectional (false), the traffic is from A to Z.
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Ticket Pane

Table 2-9 Information Displayed in the Links View (continued)

Field Name Description

Z End-Point Element or site that is the destination of the link as a hyperlink to the inventory
of the element or site.

Link Type Type of link, such as Physical Layer, LAG, MPLS TE Tunnel, pseudowire (PW)
or VPN.

The links view toolbar includes the tools described in Table 2-10 and the link filtering buttons described
in Table 2-10.

Table 2-10 Link Filtering Buttons
Button |Name Description
@ All Links Displays the complete list of links for the selected context (map or

aggregation). In other words, the list is not filtered and all the links are
displayed, including external links.

= External Links |Displays links with only one side of the link in this context (map or
aggregation) and the other side either not in the map or outside the selected
context.

Flat Links Displays the links currently visible on the map for the selected context
play y p
(map or aggregation), excluding any thumbnails.

Deep Links Displays the links for the current aggregation where both endpoints are
within the currently selected context.

For more information about filtering and sorting links in the links view, see Viewing Link Properties in
the Links View, page 6-8.

For information about the right-click options available in the links view, see Links View Right-Click
Menu, page 2-37.

The ticket pane shows the tickets that relate to the elements in the displayed map. It also contains the
Latest Events tab that shows the latest incoming events for the elements in the map from the time the
map was opened. See Chapter 10, “Working with Tickets in Cisco Prime Network Vision” for more
information.

Prime Network Vision Status Indicators

The following topics describe the ways in which the status of an element is displayed in Prime Network
Vision:

e Severity, page 2-17

e VNE Management State, page 2-18

e Tickets, page 2-22

Cisco Prime Network 3.10 User Guide
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Severity indicates the operational health of the element. An element has only one severity value at any
given time, and this value is displayed using a severity color. For more information about the colors used
to display the severity (or propagated severity) of network elements and links, see Alarm Indicators,
page 2-11.

Propagation

Severity is propagated upward in the network hierarchy, displaying the top-most severity of the network
element’s children and thereby ensuring that every single problem in the network is propagated and
visible.

The same severity propagation rules that are used for network elements apply to links. A link is a child
object of an aggregation only if it is fully contained in the aggregation; that is, the network elements on
both sides of the link are part of the aggregation, as shown in Figure 2-6 and Figure 2-7.

Figure 2-6 Link Severity Example 1

1 2

mm——

2 S
<J.’
180111

______

Figure 2-6 shows critical link 1 between two network elements in an aggregation. This critical link
affects the severity of aggregation 2. That is, the aggregation is critical because it contains a link with a
critical severity. Link severity affects the context.

Figure 2-7 Link Severity Example 2

-

180112

Figure 2-7 shows critical link 1 that forms part of a link aggregation. This affects the severity of link 2
because it contains a link with a critical severity.

New Ticket Propagation

A new ticket indicates a new local fault or accumulates and propagates the number of new faults in its
children.

[ oL-28065-01
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When new tickets are accumulated, a label is displayed in the navigation pane and map, based on the
following formula:

ns[+]

where:

Symbol |Description

n The number of alarms with the highest severity that have the source as the
network element and are part of the network element ticket(s).
s The highest severity level in the new tickets:
e (C = Critical
e M = Major

e m = Minor
e W = Warning
e N = Normal (cleared alarm)

e = Informational

+ Additional, less severe tickets (optional) exist.

For example:
¢ An object with three critical new alarms, two major alarms, and one warning alarm is labeled 3C+.
¢ An object with five minor new alarms is labeled Sm.

An icon represents unacknowledged tickets, and the icon color is that of the most severe,
unacknowledged ticket. For more information about severity colors and icons, see Alarm Indicators,
page 2-11.

If all relevant tickets are acknowledged, no bell is displayed.

VNE Management State

The management state indicates the state or mode of the software component (a VNE) managing a
network element and the communication with it. This enables you to determine the accuracy of the
network information and the availability of VNEs to carry out network operations.

Management states are always local indications and are not propagated. A partial exception to this rule
is the propagation of unreachable VNEs.

The management state indication applies only to VNE and its components. A VNE can have only one
state at a time (for example, Unsupported or Connecting).

A managed VNE icon consists of a managed element icon and one or two overlay icons, or badges:

¢ The managed element icon displays a symbol of the element, and the color of the symbol indicates
the highest severity ticket that is not cleared for the element.

An element icon is colored green if either of the following is true:
— No ticket of any severity exists for the element.

— All tickets that exist for the element have the severity Cleared or Informational.

Cisco Prime Network 3.10 User Guide
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For more information about network element icons, see Element Icons, page 2-8. For more
information about severity colors, see Alarm Indicators, page 2-11.

e An alarm badge is displayed on top of a managed element icon, and the color of the alarm badge
indicates the severity of the highest severity ticket that is not acknowledged for the element. If all

tickets are acknowledged, no alarm icon appears.
Figure 2-8 shows an example of an element with the following ticket and alarm severities:

— The highest severity ticket that is not cleared for the element is Major, as indicated by the orange
color applied to the element icon.

— The highest severity alarm that is not acknowledged for the element is Cleared or OK, as
indicated by the green alarm badge.

Figure 2-8 Element with Ticket and Alarm Severity Indicators

(@)

5

c7-sw9 [1M+]

;o613

1 |Element icon with severity Major (orange)

2 |Alarm badge with severity Cleared or OK (green)

e A VNE management state badge is displayed on top of the managed element icon to indicate the
management state of the VNE in the navigation tree and map. For example, a router that is partially
reachable by Prime Network Vision is displayed as illustrated in Figure 2-9.

Figure 2-9 Element with Overlay Badges

O—
=4

=

310517

®

1 |Alarm badge with severity Warning.

2 |Managed element icon with severity Warning.

3 | VNE management state badge of Device Partially Reachable.
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Table 2-11 and Table 2-12 describe network element communication and investigation states and shows
the related badge for each state.

Table 2-11 VNE Communication States
State Name Description Badge
Agent Not Loaded The VNE is not responding to the gateway because it was stopped, or it was just None

created. This communication state is the equivalent of the Defined Not Started
investigation state.

VNE/Agent Unreachable The VNE is not responding to the gateway. This can happen if the unit or AVM is =
overutilized, the connection between the gateway and unit or AVM was lost, or the
VNE is not responding in a timely fashion. (A VNE in this state does not mean the
device is down; it might still be processing network traffic.)

Connecting The VNE is starting and the initial connection has not yet been made to the device. |None
This is a momentary state. Because the investigation state decorator (the hourglass)
will already be displayed, a special GUI decorator is not required.

Device Partially Reachable |The VNE is not fully reachable because at least one protocol is not operational. Ed

Note This is the default behavior. You can change the settings that determine when
Cisco Prime Network moves a VNE to Device Unreachable. For more
information, see the Cisco Prime Network 3.10 Administrator Guide.

Device Unreachable The connection between the VNE and the device is down because all of the protocols e
are down (though the device might be sending traps or syslogs).

Note  This is the default behavior. You can change the settings that determine when
Cisco Prime Network moves a VNE to Device Unreachable. For more
information, see the Cisco Prime Network 3.10 Administrator Guide.

Tracking Disabled The reachability detection process is not enabled for any of the protocols used by the |None
VNE. The VNE will not perform reachability tests nor will Cisco Prime Network
generate reachability-related events. In some cases this is desirable; for example,
tracking for Cloud VNEs should be disabled because Cloud VNEs represent
unmanaged network segments.

Because this is a user-defined mode (rather than an error or transitional mode),
Cisco Prime Network does not display a decorator for this state. To troubleshoot a
VNE that is in this state, see the Cisco Prime Network 3.10 Administrator Guide.

Table 2-12 VNE Investigation States
State Name Description Badge
Defined Not Started A new VNE was created (and is starting); or an existing VNE was stopped. In this |None

state, the VNE is managed and is validating support for the device type. (This
investigation state is the equivalent of the Agent Not Loaded communication state.)
A VNE remains in this state until it is started (or restarted).

Unsupported The device type is either not supported by Prime Network or is misconfigured (it is @
using the wrong scheme, or is using reduced polling but the device does not support
it).

To extend Cisco Prime Network functionality so that it recognizes unsupported

devices, use the VNE Customization Builder. See the Cisco Prime Network 3.10
Customization Guide.

Cisco Prime Network 3.10 User Guide
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Table 2-12 VNE Investigation States (continued)
State Name Description Badge
Discovering The VNE is building the model of the device (the device type was found and is @

supported by Cisco Prime Network). A VNE remains in this state until all device
commands are successfully executed at least once, or until there is a discovery
timeout.

Operational The VNE has a stable model of the device. Modeling may not be fully complete, but |None
there is enough information to monitor the device and make its data available to other
applications, such as activation scripts. A VNE remains in this state unless it is
stopped or moved to the maintenance state, or there are device errors.

Currently Unsynchronized |The VNE model is inconsistent with the device. This can be due to a variety of ﬁ
reasons; for a list of these reasons along with troubleshooting tips, see the topic on
troubleshooting VNE investigation state issues in the Cisco Prime Network 3.10
Administrator Guide.

Maintenance VNE polling was suspended because it was manually moved to this state (by @
right-clicking the VNE and choosing Actions > Maintenance). The VNE remains in
this state until it is manually restarted. A VNE in the maintenance state has the
following characteristics:

e Does not poll the device, but handles syslogs and traps.
e Maintains the status of any existing links.
e Does not fail on VNE reachability requests.

e Handles events for correlation flow issues. It does not initiate new service alarms,
but does receive events from adjacent VNEs, such as in the case of a Link Down
alarm.

The VNE is moved to the Stopped state if: it is VNE is moved, the parent AVM is
moved or restarted, the parent unit switches to a standby unit, or the gateway is
restarted.

Partially Discovered The VNE model is inconsistent with the device because a required device command (]
failed, even after repeated retries. A common cause of this state is that the device '
contains an unsupported module.

To extend Cisco Prime Network functionality so that it recognizes unsupported
modules, use the VNE Customization Builder. See the Cisco Prime Network 3.10
Customization Guide.

Shutting Down The VNE has been stopped or deleted by the user, and the VNE is terminating its @
connection to the device.

Stopped The VNE process has terminated; it will immediately move to Defined Not Started. |None

More than one management state can occur at the same time. For example, a single overlay icon can be
displayed, reflecting the device status based on the following priorities:

Unsupported > Discovering > VNE/Agent Unreachable > Device Unreachable > Partially

Discovered > Operational.

For more information about each of these states and how to troubleshoot any issues, see the Cisco Prime
Network 3.10 Administrator Guide.

Cisco Prime Network 3.10 User Guide
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Tickets

Cisco Prime Network Vision displays an icon with a ticket to indicate the severity of the top-most alarm
on the ticket. The icons are the same as those used with network elements (see Table 2-5) and are
displayed in Cisco Prime Network Vision as follows:

Value Navigation Pane Map Ticket Pane
Element with ticket of E—T;jw L Severity | Ticket 1D
Major severity @ v 520030

Prime Network Vision Toolbar

The Prime Network Vision toolbar is context-sensitive and the options vary depending on your selection
in the application.

~

Note  The functionality that a user can access in Prime Network Vision depends on the user role and the
security level of the scopes assigned to the user. For more information, see User Roles Required for
Working with Prime Network Vision Maps, page 5-2.

Table 2-13 identifies the toolbar buttons and describes the functions that are available in the Prime
Network Vision toolbar.

Table 2-13 Prime Network Vision Toolbar
Button Name Function
= . Open Network Opens the Network Elements tab.
= Inventory
Map Options
New Map Creates a new map in the database.
E?’* Open Map Opens a map saved in the database using the Open dialog box.
@ « |Add to Map Adds an element to the map or to the subnetwork selected in the
navigation pane and displayed in the content pane.
H Save Map Saves the current map (the background and the location of devices)
Appearance to the database.

Viewing Options

Show Map View Displays the map view in the Prime Network Vision content pane
(the button toggles when selected or deselected).

% Show List View Displays the list view in the Prime Network Vision content pane (the
button toggles when selected or deselected).

Cisco Prime Network 3.10 User Guide
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Table 2-13 Prime Network Vision Toolbar (continued)
Button Name Function
£ Show Links View |Displays the links view in the Prime Network Vision content pane

(the button toggles when selected or deselected).

Overlay Tools

= -

Choose Overlay
Type

Chooses and displays an overlay of a specific type on top of the
elements displayed in the content pane in a map view.

Available overlay options are:
e Ethernet Service
e MPLS-TP Tunnel
e Network Clock

e Pseudowire

e VLAN
e VPLS
e VPN

e None—Removes the existing overlays.

(i

Show Overlay /
Hide Overlay

Displays or hides a previously defined overlay on top of the
elements displayed in the map view.

Note  Overlays do not reflect changes that occur in the selected
service. As a result, the information in an overlay can
become stale.

@

Refresh Overlay

Refreshes the overlay that was last selected.

Viewing Tool

S

2]

Go to Parent

Moves up one level in the navigation pane and content pane so you
can view different information.

Link Filter

Opens the Link Filter dialog box, enabling you to display or hide
different types of links in the map and links views.

If a link filter is applied to the map, the Link Filter Applied button
is displayed instead.

Link Filter Applied

Indicates a link filter is currently applied to the map and opens the
Link Filter dialog box so you can remove or modify the existing link
filter.

If no link filter is applied to the map, the Link Filter button is
displayed instead.

Overview

Opens a window displaying an overview of the network.

Find Business Tag

Opens the Find Business Tag dialog box, enabling you to find and
delete a business tag according to name, key, or type.

[ oL-28065-01
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Table 2-13

Prime Network Vision Toolbar (continued)

Button

Function

Search Tools

[«

Find Previous

Finds the previous instance of the search string entered in the Find
in Map dialog box.

m Find Opens the Find in Map dialog box, enabling you to find an element
in the map by its name or IP address.
Find Next Finds the next instance of the search string entered in the Find in

[»]

Map dialog box.

Map Zoom and Layout Tools

M -

Layout Map

Defines the way in which the elements are arranged in the Prime
Network Vision window: Circular, hierarchical, orthogonal, or
symmetric.

3

Fit in Window

Fits all elements in the map in the content pane.

Normal Selection
Mode

Activates the normal selection mode.

Zoom Selection
Mode

Activates the zoom selection mode, which enables you to zoom in
on a section of the map by clicking and dragging the required area.

T

Pan Mode

Activates the pan mode, which enables you to view different areas
of the map by clicking and dragging the map.

Application-Specific Tools

2

Open Activation

Opens the Activation dialog box.

For more information, see the Cisco Prime Network 3.10
Customization Guide.

=

Activation History

Opens the Activation History dialog box.

For more information, see the Cisco Prime Network 3.10
Customization Guide.

Prime Network Vision Menu Bar

The following topics describe the options that are available in each Prime Network Vision menu:

e File Menu, page 2-25

Edit Menu, page 2-26

e View Menu, page 2-26
e Node Menu, page 2-27

e Tools Menu, page 2-27

e Activation Menu, page 2-28

e Network Inventory Menu, page 2-28

] Cisco Prime Network 3.10 User Guide
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File Menu
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e Reports Menu, page 2-29

e Window Menu, page 2-29

e Help Menu, page 2-29

The functionality that a user can access in Prime Network Vision depends on the user role and the
security level of the scopes assigned to the user. For more information, see User Roles Required for
Working with Prime Network Vision Maps, page 5-2. Also, the menus are context-sensitive and the
options vary depending on your selection in the application.

Table 2-14 describes the options that are available in the Prime Network Vision File menu. For more
information, see Chapter 5, “Working with Prime Network Vision Maps.”

Table 2-14 File Menu Options

File Menu Option

Description

New Map

Creates a new empty map in the database.

Open Map

Opens a map saved in the database using the Open dialog box.

Add to Map!

Opens the Add dialog box and enables you to add any of the following to the map
or to the subnetwork selected in the navigation pane and displayed in the content
pane:

¢ Cross Connect

e Ethernet Service

e MPLS-TP Tunnel

e Network Element

e Pseudowire

e Unassociated Bridge
e VLAN

e VPLS

e VPN

Save Map'

Saves the appearance of the map (the background and the location of devices) to
the database.

Save As Image!

Saves the active map as an image and automatically displays the Save as Image
dialog box. Use this dialog box to save an image using a different file format or
name.

Print Preview'

Displays how the map will look when it is printed.

Print!

Prints the active map as displayed in the Print Preview dialog box.

Load MultiPath

Loads a Cisco PathTracer multiple-path trace from a file that was previously
saved in Cisco PathTracer.
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Edit Menu

View Menu

Table 2-14

File Menu Options (continued)

File Menu Option

Description

Close

Closes the selected map or tab.

Exit

Exits the Prime Network Vision application and saves the content pane.

1. This option is available only when a map is displayed in the content pane.

Table 2-15 identifies the options available in the Prime Network Vision Edit menu. For more
information, see Chapter 5, “Working with Prime Network Vision Maps.”

Table 2-15 Edit Menu Options
Edit Menu Option Description
Find in Map Searches for a device in the map that contains the specified text in the name or

the IP address fields.

Find Business Tag

Searches for business tag information in the database.

Resize This option is displayed only when element icons or aggregations are selected.
Displays the Resize dialog box, enabling you to specify the size of selected icons
or aggregations in the map, either by percentage or size.

Select All Selects all elements in the map.

Table 2-16 identifies the options available in the Prime Network Vision View menu. For more
information, see Using the Overview Window, page 5-14.

Table 2-16

View Menu Options

View Menu Option

Description

Layout Defines the way in which the map is displayed in the Prime Network Vision
content pane: Circular, hierarchical, orthogonal, or symmetric.

Overview Opens a window displaying an overview of the network map.

Zoom In Zooms in on the network map.

Zoom Out Zooms out of the network map.

Fit In Window Displays the entire network map in the content pane.

Normal Select

Activates the normal selection mode. The selected option is dimmed.

Pan

Activates the pan mode, which enables you to move around in a map by clicking
and dragging. The selected option is dimmed.

Zoom Selection

Activates the zoom selection mode, which enables you to select an area in a map
to zoom in on by clicking and dragging. The selected option is dimmed.
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Tools Menu
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Table 2-17 describes the Node menu options.

Most of the functionality available in this menu is available only when an element icon or an aggregation
is selected in the navigation pane or a map.

Table 2-17 Node Menu Options

Node Menu Option

Description

Inventory

Displays a dialog box that enables you to view the physical and logical inventory.
For physical inventory, you can view all the components of the device, such as
modules and ports. In addition, you can view the status of each component. For
logical inventory, you can view all the profiles and virtual channels or routing
tables of the device. For more information, see Chapter 3, “Viewing and
Managing NE Properties.”

Mark as A Side

Starts the process of creating a new static link. This option is enabled when a
device, port, or unmanaged network is selected.

Mark as Z Side

Launches the Add Static Link dialog box, enabling you to create a static link
between the two selected nodes. This option is enabled after a device, port, or
unmanaged network is selected and after the Mark as A Side option is selected.

Note If you select two ports, the Add Static Link dialog box is not displayed.

Properties

Displays a dialog box enabling you to view the properties of the selected device,
such as the severity, IP address, and communication state. For more information,
see Chapter 3, “Viewing and Managing NE Properties.”

Table 2-18 describes the Tools menu options.

Table 2-18 Tools Menu Options

Tools Menu Option

Description

Change User Enables you to change the password used when logging into the Prime Network
Password client application suite. The change takes effect the next time you log into the
application.
Note The administrator can also change a user password in Cisco Prime
Network Administration.
Options Enables you to customize several of Prime Network’s options, such as whether

or not to load the content upon startup. For more information, see Adjusting the
Prime Network Vision GUI Client Settings, page 2-39.
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Table 2-18

Tools Menu Options (continued)

Tools Menu Option

Description

Change and Config
Mgmnt

Displays the Prime Network Change and Configuration Management dashboard.

For more information, see the Chapter 4, “Device Configurations and Software
Images.”

Command Jobs

Displays all Command Builder jobs that have been scheduled and their details.

For more information, see the Cisco Prime Network 3.10 Customization Guide.

Activation Menu

See the Cisco Prime Network 3.10 Customization Guide for more information about any of the options

in this menu.

Table 2-19 describes the Activation menu options.

Table 2-19

Activation Menu Options

Activation Menu Option

Description

Activation

Opens the Activation dialog box.

Activation History

Opens the Activation History dialog box.

Activation Modification Utility

Opens the Activation Modification Utility dialog box.

Network Inventory Menu

Table 2-20 describes the Network Inventory menu options.

Table 2-20

Network Inventory Menu Options

Network Inventory
Menu Option

Description

Network Elements

Displays a list of the available network elements in the Network Elements tab.
For more information, see Prime Network Vision Inventory Tabs, page 2-4.

Ethernet Flow

Displays a list of the current Ethernet flow domains in the Ethernet Flow

Domains Domains tab. For more information, see Viewing and Renaming Ethernet Flow
Domains, page 13-41
VTP Domains Displays a list of the current of the VLAN Trunk Protocol (VTP) domains in the

VTP Domains tab. For more information, see Viewing VLAN Trunk Group
Properties, page 13-67.

Virtual Machines

Displays a list of the available virtual machines in the Virtual Machines tab. For
more information about virtual machines, see Viewing the Virtual Machines of a
Data Center, page 27-13.
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Reports Menu

Table 2-21 describes the Reports menu options.

Table 2-21 Reports Menu Options

Reports Menu Option Description

Report Manager Opens the Reports Manager window so you can create, run, and manage
reports.
Run Report Enables you to run standard or user-defined events, inventory, and network

service reports on demand.

For more information about Report Manager and reports, see Chapter 11, “Working with Reports.”

Window Menu

Help Menu

The Prime Network Vision Window menu lists all maps open in the Prime Network Vision content pane,

enabling you to move between the maps. The menu also lists any network element inventory tabs that
are open.

Table 2-22 describes the Help menu options.

Table 2-22 Help Menu Options

Help Menu Option |Description

Cisco Prime Opens the online help for Prime Network Vision and Prime Network Events.
Network Vision

Help

Icon Reference Opens a window that identifies and describes the icons and buttons used in Prime

Network Vision and Prime Network Events.

Cisco.com This option is unavailable.

About Cisco Prime |Displays the Prime Network version and any additionally installed applications.
Network Vision

Prime Network Vision Right-Click Menus

If you right-click a specific area, link, network element, device, or alarm in a Prime Network Vision
window, a context-sensitive right-click menu is displayed that contains options available for the selected
item or items.

Right-click menus are also available in many of the inventory and property windows. For example, if
you right-click an entry in a logical inventory table, you can view properties specific to that entry. The
options that are available depend on the window or table currently displayed and the item selected.
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The menus are context-sensitive and the options vary according to your selection in the application. For
example, the right-click menus for network elements and aggregations are different.

Additional right-click options are displayed in the following situations:

e If Prime Network is installed as part of the Cisco Prime suite of applications, right-click menus in
Prime Network Vision include options for accessing the other Cisco Prime applications.

e If Prime Performance Manager is installed in your environment, Prime Network Vision includes
right-click options that allow you to generate device, interface, and VRF-related reports using Prime
Performance Manager.

e The Prime Network Vision installation includes a number of scripts. When these scripts are
installed, they are displayed as options in the right-click menus of the devices that support them. For
more information about these scripts, see Configuring and Viewing NEs using Basic Management
Commands, page 3-37.

The functionality that you can access in Prime Network Vision depends on your user role and the security
level of the scopes that you can access. For more information, see User Roles Required for Working with
Prime Network Vision Maps, page 5-2.

See the following topics for the default options available in Prime Network Vision right-click menus:
e Map Right-Click Menu, page 2-30
e FElement Right-Click Menu, page 2-31
e Aggregation Right-Click Menu, page 2-34
¢ Link Right-Click Menu, page 2-35
e List View Right-Click Menu, page 2-35
e Links View Right-Click Menu, page 2-37
e Ticket Right-Click Menu, page 2-38

Map Right-Click Menu

The map right-click menu is displayed when you right-click anywhere on a map in the content pane and
no elements are selected.

Table 2-23 describes the map right-click menu options.

Table 2-23 Map Right-Click Menu Options

Option Description

Go to Parent Moves up one level in the navigation pane and content pane to enable you to view
different information.

Go to Root Moves to the root level in the navigation pane and content pane to enable you to
view different information.

Set Map Displays a background image for the map in the content pane. For more

Background information, see Applying a Background Image, page 5-12.

Cisco Prime Network 3.10 User Guide
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Element Right-Click Menu

The element right-click menu is displayed when you right-click an element in the navigation pane, the
content pane, or in the Network Elements inventory tab.

~

Note  The element right-click menu is context-sensitive and the options vary depending on your selection in
the application. Also, some options might not be available if multiple elements are selected.

Table 2-24 describes the options available in the element right-click menu.

Table 2-24 Element Right-Click Menu Options

Option Description

Add Associated VLAN |Opens the Add Associated VLAN dialog box so that you can add an
associated VLAN to the selected VLAN. For more information, see Adding
an Associated VLAN, page 13-54.

Aggregate Groups the selected devices into an aggregation in the Prime Network Vision
content pane, and enables you to define a name for the new aggregation. For
more information, see Chapter 5, “Working with Prime Network Vision
Maps.”

Note  You cannot aggregate service entities that exist within services. For
example, you cannot aggregate VRFs that exist in a VLAN.

Attach / Detach / Edit  |Allows you to perform the following actions:
Business Tag e Attach a business tag to the selected network element.
e Detach a business tag from a network element.
e Edit a business tag for a network element.
Note The Detach and Edit options are displayed only when a business tag
is attached to a network element.

For more information, see Chapter 7, “Labeling NEs Using Business Tags.”

Commands Enables you to launch any of the commands that are included with Prime
Network Vision.

For more information on the available commands and how to implement
them, see Configuring and Viewing NEs using Basic Management
Commands, page 3-37.

Config Mgmnt This option is available only if Prime Network Change and Configuration
Management is installed.

Displays the Configuration Management page for the selected device in
Prime Network Change and Configuration Management.

For more information, see Chapter 4, “Device Configurations and Software
Images.”

Delete Deletes the selected item from the map.

Cisco Prime Network 3.10 User Guide
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Table 2-24 Element Right-Click Menu Options (continued)

Option Description

Disaggregate Ungroups the devices in the selected aggregation in the navigation and map
panes. For more information, see Chapter 5, “Working with Prime Network
Vision Maps.”
Note  This option is available only when an aggregation is selected in the

navigation pane or map.
Edit Move the selected virtual router to the location you specify.
Filter Tickets Displays only those tickets that have the selected VNE as the root cause.

This option is available only for VNEs that have not been deleted by Prime
Network Administration.

Hide Connected
Devices

Hides the devices for sites with one or more connected devices.

Image Mgmnt

This option is available only if Prime Network Change and Configuration
Management is installed.

Displays the Image Management page for the selected device in Prime
Network Change and Configuration Management.

For more information, see Chapter 4, “Device Configurations and Software
Images.”

Inventory

Displays a window enabling you to view the physical and logical inventory.
For physical inventory, you can view all the components of the device, such
as the modules, ports, and its IP address or configured VLANS. In addition,
you can view the status of each component. For logical inventory, you can
view all the profiles and VC tables of the device. For more information, see
Chapter 3, “Viewing and Managing NE Properties.”

Launch external
applications

Starts an external application or tool that has been configured for access via
the right-click menu. For more information, see the Cisco Prime Network
3.10 Customization Guide.

Management

Contains the following submenu options:

¢ Command Builder—Defines commands and scripts using the Prime
Network Command Builder tool (Configurator security level required).

e Soft Properties Management—Extends VNEs by adding SNMP MIB or
Telnet/SHH/TL-1 properties to the device’s collected information model
using the Prime Network Soft Properties Manager (Administrator
security level required).

For more information about Command Builder and Soft Properties Manager,
see the Cisco Prime Network 3.10 Customization Guide.

Modify

Displays the Modify dialog box so that you can change the selected item’s
name, description, or icon.

Open Relevant Maps

Displays the Open Map dialog box so that you can view and open maps that
contain the selected element.

PathTracer

Launches a path trace from the selected item.

Poll Now

Polls the selected element.
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Table 2-24 Element Right-Click Menu Options (continued)
Option Description
Properties Displays the properties of the selected item, such as the IP address and

system name. In addition, you can open the VNE Properties dialog box and
manage VNE properties. For more information, see Chapter 3, “Viewing and
Managing NE Properties.”

Remove from Map

Removes the selected device and all its children from the map (navigation
pane and content pane). The device that has been removed is still maintained
in the network.

Rename Renames the selected item.
Resize Enables you to resize an object on the map by percentage or size.
Run Report Enables you to run standard or user-defined events, inventory, and network

service reports on demand.

Save as New Map

Creates a new map and places the selected aggregation as the root, while
leaving the original map intact.

Script names

Launches available activation and configuration scripts. This can include the
commands documented in Configuring and Viewing NEs using Basic
Management Commands, page 3-37.

Show as Aggregation /
Thumbnail

Displays the selected aggregation as a single entity or as a collection of
items.

The options toggle, depending on whether the aggregation is in a thumbnail
or aggregated view.

Show CE Device

Displays devices for sites or LCPs with one or more hidden, connected
devices.

Tools

The Tools option contains the following choices:

e CPU Usage—Displays memory and CPU usage information for a device
or network element.

e Ping—Pings the device from the client station.

¢ Telnet—Communicates with the device using the Telnet window from
the client station.

Note If you are using a Windows 7 system and want to use the Prime
Network Telnet option, you need to set up Telnet on the Windows 7
system as follows:

- For Windows 7 32-bit systems, enable the Windows Telnet Client
to use the Prime Network Telnet option.

- For Windows 7 64-bit systems, a solution is available on the
Cisco Developer Network at
http://developer.cisco.com/web/prime-network/forums/-/message_b
oards/message/2780108.
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Table 2-24 Element Right-Click Menu Options (continued)
Option Description
Topology The Topology option enables you to add:

e A static link between two devices.
e A static topology between a device and an unmanaged network.
e A tunnel to a VPN.

When working with static links, the following submenu options enable you
to define the A Side and Z Side of the link:

e Mark as A Side
e Mark as Z Side

When working with VPNs in VPN Service View, the Add Tunnel submenu
option allows you define and configure tunnels.

VNE Tools Contains the following submenu options:

e Poll Now—Updates the VNE information.
e Stop VNE—Stops the VNE.

e Start VNE—Starts the VNE.

For more information, see Chapter 3, “Viewing and Managing NE
Properties.”

Aggregation Right-Click Menu

The aggregation right-click menu is displayed when you right-click an aggregation in a map.

Table 2-25 describes the aggregation right-click menu options.

Table 2-25 Aggregation Right-Click Menu Options

Option Description

Aggregate Groups the selected aggregations into an aggregation in the Prime Network
Vision content pane, and enables you to define a name for the new aggregation.
For more information, see Chapter 5, “Working with Prime Network Vision
Maps.”

Disaggregate Ungroups the selected aggregation in the navigation pane and map in the Prime
Network Vision window. All the aggregations in the selected node move up one
level, and the original aggregation is removed. For more information, see
Chapter 5, “Working with Prime Network Vision Maps.”

Rename Renames the selected aggregation.

Resize Defines the size of selected aggregations in a map according to one of four sizes
or according to a percentage of the current size.

Remove from Map |Removes the selected aggregation and all its children from the navigation pane
and the map.

Save as New Map |Creates a new map and places the selected aggregation as the root, while leaving
the original map intact.
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Table 2-25 Aggregation Right-Click Menu Options (continued)

Option

Description

Run Report

Enables you to run standard or user-defined events, inventory, and network
service reports.

Show as
Aggregation /
Thumbnail

Displays the aggregation as a single entity or as a collection of items.

The options toggle, depending on whether the aggregation is in a thumbnail or
aggregated view.

Delete

Deletes the selected item.

This option is available when the item is marked with the reconciliation icon.

Link Right-Click Menu

The Link right-click menu is displayed when you right-click a link in the map view. For more
information, see Chapter 6, “Working with Links.”

Table 2-26 describes the link right-click menu options.

Table 2-26 Link Right-Click Menu Option

Option

Description

Properties

Displays the properties of the selected link.

List View Right-Click Menu

The list view right-click menu is displayed when you right-click an entry in the Network Elements tab
in the list view table. For more information, see List View, page 2-11.

Table 2-27 describes the list view right-click menu options.

Table 2-27 List View Right-Click Menu Options - Network Elements Tab
Option Description
Inventory Displays a window enabling you to view the physical and logical inventory.

For physical inventory, you can view all the components of the device, such
as the modules, ports, and its IP address or configured VLANS. In addition,
you can view the status of each component. For logical inventory, you can
view all the profiles and VC tables of the device. For more information, see
Chapter 3, “Viewing and Managing NE Properties.”

Attach / Detach /
Edit Business Tag

Allows you to perform the following actions:
e Attach a business tag to the selected element.
e Remove a business tag from the selected element.
e Edit an existing business tag for the selected element.
Note The Detach and Edit options are available only when a business tag

is attached to a link.

For more information, see Chapter 7, “Labeling NEs Using Business Tags.”
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Table 2-27 List View Right-Click Menu Options - Network Elements Tab (continued)

Option

Description

Config Mgmnt

Displays the Configuration Management page for the selected device in
Prime Network Change and Configuration Management.

For more information, see Chapter 4, “Device Configurations and Software
Images.”

Image Mgmnt

Displays the Image Management page for the selected device in Prime
Network Change and Configuration Management.

For more information, see Chapter 4, “Device Configurations and Software
Images.”

Run Report

Enables you to run standard or user-defined events, inventory, and network
service reports.

Show Only
Selected Rows

Displays only the rows that you select.

Show All Rows

Displays all table rows that meet the current filtering criteria.

Tools

Contains the following submenu options:

e CPU Usage—Displays memory and CPU usage information for a device
or network element.

e Ping—Pings the device from the client station.

e Telnet—Communicates with the device using the Telnet window from
the client station.

Note If you are using a Windows 7 system and want to use the Prime
Network Telnet option, you need to set up Telnet on the Windows 7
system as follows:

- For Windows 7 32-bit systems, enable the Windows Telnet Client
to use the Prime Network Telnet option.

- For Windows 7 64-bit systems, a solution is available on the
Cisco Developer Network at
http://developer.cisco.com/web/prime-network/forums/-/message_b
oards/message/2780108.

Topology

Enables you to add:
* A static link between two devices.
e A static topology between a device and an unmanaged network.
e A tunnel to a VPN.

When working with static links, the following submenu options enable you
to define the A Side and Z Side of the link:

e Mark as A Side
e Mark as Z Side

When working with VPNs in VPN Service View, the Add Tunnel submenu
option allows you define and configure tunnels.
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Table 2-27 List View Right-Click Menu Options - Network Elements Tab (continued)

Option

Description

Launch external

Launches external applications or tools, such as an SSH client. See the

applications Cisco Prime Network 3.10 Customization Guide.

Properties Displays the properties of the selected item, such as the IP address and
system name. In addition, you can open the VNE Properties dialog box and
manage VNE properties. For more information, see Chapter 3, “Viewing and
Managing NE Properties.”

Commands Enables you to launch any of the commands that are included with Prime

Network Vision. For a complete list of the available commands, see
Configuring and Viewing NEs using Basic Management Commands,
page 3-37.

Script names

Launches available activation and configuration scripts. This can include the
commands documented in Configuring and Viewing NEs using Basic
Management Commands, page 3-37, and those you create using Command
Builder (can be launched against multiple network elements). For more
information, see the Cisco Prime Network 3.10 Customization Guide.

Management Contains the following submenu options:
e Command Builder—Defines commands and scripts using the Prime
Network Command Builder tool (Configurator security level required).
e Soft Properties Management—Extends VNEs by adding SNMP MIB or
Telnet/SHH/TL-1 properties to the device’s collected information model
using the Prime Network Soft Properties Manager (Administrator
security level required).
For more information about Command Builder and Soft Properties Manager,
see the Cisco Prime Network 3.10 Customization Guide.
VNE Tools Contains the following submenu options:

e Poll Now—Updates the VNE information.
e Stop VNE—Stops the VNE.
e Start VNE—Starts the VNE.

For more information, see Chapter 3, “Viewing and Managing NE
Properties.”

Links View Right-Click Menu

The links view right-click menu is displayed when you right-click a link in the links view table. For more
information, see Chapter 6, “Working with Links.”

Table 2-28 describes the links view right-click menu options.
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Table 2-28 Links View Right-Click Menu Options

Option Description

Attach Business Attaches a business tag to the selected link. For more information, see Chapter 7,
Tag “Labeling NEs Using Business Tags.”

Detach/Edit Detaches or edits a business tag from the selected link. For more information, see
Business Tag Chapter 7, “Labeling NEs Using Business Tags.”

The Detach and Edit options are available only when a business tag is attached
to a link.

Select Link in Map |Highlights the selected link in the content pane.

Show Only Displays only the rows that you select.

Selected Rows

Show All Rows Displays all table rows that meet the current filtering criteria.
Properties Displays the properties of the selected link.

Ticket Right-Click Menu

The Ticket right-click menu is displayed when you right-click a ticket in the ticket pane. The Ticket
right-click menu enables you to view ticket properties and highlights the links or elements that are
affected by a ticket. The Ticket menu also enables you to acknowledge, clear, and remove a ticket. For
more information, see Chapter 10, “Working with Tickets in Cisco Prime Network Vision.”

Table 2-29 describes the ticket right-click menu options.

Table 2-29 Ticket Right-Click Menu Options
Option Description
Acknowledge Acknowledges that the ticket is being handled; the ticket is displayed as true in

the ticket pane. Acknowledging an alarm removes the alarm icon from the device
icon. Multiple tickets can be acknowledged at the same time.

Clear Approves the reported faulty ticket and clears the faulty networking entity from
Prime Network. The ticket is displayed as Clear in the ticket pane.

Note  When a Card Out or Link Down alarm occurs, the relevant information is
displayed in the inventory and maintained in the VNE.

Remove Removes the ticket and all its active subtickets from the ticket pane (this option
is only available after the ticket has been cleared). The deleted tickets can be
viewed using Cisco Prime Network Events. Multiple tickets can be removed at
the same time.

Note  When a ticket is removed, the information is no longer displayed in the
inventory and is removed from the VNE.

Clear and Remove |Approves the reported faulty ticket and clears the faulty networking entity from
Prime Network. In addition, the ticket and all its active subtickets are removed
from the ticket pane.
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Ticket Right-Click Menu Options (continued)

Option

Description

Find Affected
Elements

Finds any elements affected by the selected ticket:

e If only one element is affected, it is selected in the Prime Network navigation
pane and content area.

e If multiple elements are affected, they are displayed in the Affected
Elements window.

Show Only
Selected Rows

Displays only the rows that you select.

Show All Rows

Displays all table rows that meet the current filtering criteria.

Properties

Displays the Ticket Properties dialog box, enabling you to view ticket
information, including impact analysis details of the affected parties and

correlated alarms. See Viewing Ticket Properties, page 10-10.

Adjusting the Prime Network Vision GUI Client Settings

Table 2-30 lists the options for changing the GUI client display and audio settings, and for controlling
the startup view and event history. You can adjust these settings by selecting Tools > Options from the

main menu.

Table 2-30 Options for Changing Prime Network Vision GUI Client

Field Description

Startup

Load Open to content pane on login. Check the box if you do not want to view the content pane

Workspace on  |when you log in.

Startup

Display Tab

Preferences Map Labels Font size for map labels (26, 28, 30, 32, and 34; 30 is the default).
Font Size

Severity Show Severity |List severity levels in the navigation pane and maps, using the formula
Text described in New Ticket Propagation, page 2-17. Check the box if you
(e.g. [3M+] do want to see severity text.
Show View both acknowledged and unacknowledged alarms in the network

Acknowledged |element display name. Check the box if you do want to see both

unacknowledged and acknowledged alarms.

Show View propagated alarms on the specific entity. Propagated alarms are
Propagated those that occur on other NEs. Check the box if you do want to see

propagated alarms.

Display Name

How NE name is displayed:

Do not use Business Tag—Display NE name only
Add Business Tag to name—Display NE name and business tag.

Replace name with Business Tag—Display business tag only (when a subscriber is
attached to a port, the subscriber name is also added)
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Table 2-30 Options for Changing Prime Network Vision GUI Client (continued)
Field Description
Audio Tab

Enable Audio
Response for
Alarm

Audio notification settings. Check the box if you do want a sound to be issued when an
alarm is triggered.

Critical The .wav file to use for critical alarms.
Major The .wav file to use for major alarms.
Minor The .wav file to use for minor alarms.

Loop Sound on
Critical Alarm

If critical alarm sound should sound continuously when a critical alarm is triggered.
Check the box if you do want a sound to play continuously.

Events Tab

Events History
Size in Hours

Maximum age of events to display in the Network Events and Provisioning Events tab in
the inventory window (see Ticket and Events Pane, page 3-15). If you only want to see
active events, enter 0 (zero). The default (6 hours) is controlled from the Prime Network
Administration GUI client.

Filtering and Sorting Tabular Content

For tables with extensive data, you can view all of the information in a table cell by hovering your mouse
cursor over the cell. These topics explain how to sort and filter tabular information.

Step 1

Sorting Tables

Sorting a table lets you arrange existing data in various ways, while filtering a table only displays the
information that matches the filter.

To sort a table using the Sort Table Values option:

In the table toolbar, click Sort Table Values. The Sort dialog box is displayed.

Figure 2-10

Sort

Sort Dperation

Sort Dialog Box

Once Only (8) Continuously/Repeatedly
Sort By | Pseudowire Type v | | Ascending w | ITl ITl
Then By | Diescripkion - | | Ascending - | ITl ITl
Then By | Mame - | | Ascending - | (-1[+]
i, | Cancel |

310523
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Step 2

Step 3

Step 4
Step 5

Step 6

Note

Filtering and Sorting Tabular Content

In the Sort Operation field, specify the frequency of the sort operation:

¢ Only Once—Sorts the information in the table only once according to the specified criteria. When
this option is selected, newly added rows will always be listed at the bottom of the table, regardless
of their sort criteria value. Also, if an existing row's value changes, the row will remain where it is.

¢ Continuously/Repeatedly—Sorts the information in the table continuously according to the
specified criteria.

If you select this option, the ®

icon is displayed next to the selected column heading.
In the Sort By field, specify the first sort criterion:
a. In the first drop-down list, choose the column to use for the first sort criterion.

b. In the second drop-down list, choose Ascending or Descending to indicate the sort order.

If needed, click| i ‘to add another sort criterion.

Adjust the sort criteria as needed:

e To add additional criteria, click| 2.

e To remove a criterion, click o .

Click OK to sort the table using the specified criteria.

Filtering Tables

Filtering can be extremely helpful when working with tables that contain many entries.

If you load a table with many entries, (for example, thousands of entries), it can take a while for the
complete table to load. The filtering options in the table toolbar are unavailable until the table has
completely loaded.

You can tell a table is being filtered if any filter details are displayed in the status line below the table or
when you hover the mouse cursor over the filter button.

Table 2-31 Table Toolbar Options
Option Name Description
Filter Filters the information displayed in the table by the
W criteria you specify.
For more information, see Filtering Tables,
page 2-41.
!7 Clear Filter Clears the existing filter.
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To define a filter:

Step1  In the toolbar above the table, click Filter. The Filter dialog box is displayed as shown in Figure 2-11.

Figure 2-11 Table Filter Dialog Box
Filter X
Match of the Following rules
| Conkext v | | Caonkains - &
oK _ Caneel _ Clear

236844

Step2  In the Match drop-down list, choose the rule for including items that meet the specified criteria:
e All—AIl of the following criteria are to be met.
e Any—Any of the following criteria are to be met.

Step3  For each criterion, specify the following information:

a. In the first drop-down list, choose the primary match category. The drop-down list contains all
columns in the current table.

b. In the second drop-down list, choose the rule to use for this criterion.

¢. The third field either lists the available values or allows you to enter text using a drop-down list or
free text.

Tip You can use the “Greater than” or “Less than” rule with a string for filtering. For example, if you
want to include all interfaces above Ethernet0/0/3, you can select Greater than and enter the
string Ethernet0/0/3 to view interfaces Ethernet0/0/4, Ethernet0/0/5, and so on.

Stepd  Click * *' to add another criterion for this filter.

Step 5 Add additional criteria as required. To remove a criterion, click =
Step6  When you have specified all criteria for the filter, click OK.

The table data is displayed using the defined filter.
Step 7 To clear a filter, click Clear Filter in the table toolbar.

The table is refreshed and all entries are displayed.
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